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Part 2. A Little Bit Beyond the Basics

Chapter 5. Getting Your Stuff into iDVD

Now that you've planned your project—whether you're documenting your brother's wedding, reliving your vacation to the
depths of Death Valley, or putting together instructional materials for co-workers—it's time to start making your own
unique DVD. In this chapter, I'll show you how to deal with situations that the quick tutorial in Chapter 3, "Introduction
to Making DVDs," didn't cover and I'll show you how to turn your DVD into a highly customized project you will truly
be proud of.

The first step, even before you open iDVD, is to collect your assets (images and video for now; I'll cover everything you
need to know about sound in Chapter 7, "Adding Audio"). Make sure your files are in the right format, and map out where
you want your slideshows and movies to go in your DVD.

After we take a quick look at each of these steps, the excitement begins—importing your masterpieces into iDVD.

Don't worry about putting a pretty face on your DVD. Yet. You're going to get to make that DVD look just the way you
want in Chapter 6, "Working with Menus and Buttons."

First, Get Your Assets Together

Before you can import a single image or video, everything needs to be in the right file format. Chances are, your images
are already in the right format since iDVD will accept any QuickTime-compatible still-image file.

Graphic images can be formatted as TIFF, PICT, JPEG, or any other QuickTime
format.

I use TIFF because it's a "lossless" format and I never want to throw away information I might need later.

% That doesn't mean you should comb your hard disk and change all your images to
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% TIFF. It's best to leave them alone if they're already in a QuickTime format. Every time

you compress or re-save a file with compression, you take away resolution that can
never be put back.

As arule, you always want to use the best or highest-quality source material and let any degradation come from iDVD's

compression when you burn the disc. After all, if you give iDVD a pixelated, overly compressed JPEG file, for instance,
iDVD isn't going to make it look better, if you know what I mean.

The same rule about format holds true for video—iDVD will accept almost any QuickTime-compatible video file (except
QuickTime VR, MPEG-1, and formats with sprites). But that doesn't mean all video formats are created equal, at least not

in the eyes of iDVD. You'll get the best results if video you intend to use in iDVD is exported (or saved) in the DV
Stream format.

For the best results, Apple recommends using a video frame rate of 29.97 frames per
second (fps), no compression for audio, and an audio rate of 48 kHz. That's probably
what your DV camcorder outputs, so don't worry too much about it.

If you're using iMovie 3, you don't have to do anything—iMovie does it all for you every time you save your project:

iMovie: Export

Export: To iDVD T]

iMovie 3 automatically prepares projects
for iDVD every time they are saved. It is no
longer necessary to ‘Export to iDVD.'

Click Export to send your movie to iDVD
directly; you can also set chapter markers
in the iDVD pane.

/ Cancel \ / Export \

If you're using Final Cut—Express or Pro—do the following:

1. Choose Export from the File menu, then choose QuickTime from the Export sub-menu.
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Choose DV Stream from the Save dialog pop-up Format menu.
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3.  Click the Save button to save the exported DV Stream file to disk.

If you want to check export settings, click Options instead of Save.

DV Export Settings

DV Format: [ pv 49

Video Format:
@ NTSC
OrAL

Audio Format:
I Locked

Save As:[SIIIFeIss.dv Rate: (48.000 KHz

Where: ' [ Desktop

Format: ' DV Stream

Use: fMost Recent Settings
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Speaking of options, if you're sending your DVD across the briny seas—to Europe, that is—make sure you use the right
format for videos. Since our Euro-pals have tellies that use the PAL format rather than NTSC, there are two additional
steps you need to perform.

1.  When you export your movies from your video-editing software, you need to choose the PAL format and a frame
rate of 25 fps.

2.  Before you import your movies into iDVD, choose Preferences from the iDVD menu, click the General button in the
toolbar (it looks like a lightswitch), then select the PAL option, as shown in Figure 5.1.

Figure 5.1. It's important to let iDVD know if you want to use the PAL format before you start your
iDVD project or you'll have to start from scratch.

(&) General o

1] = @

General Slideshow Movies

Project Settings

@ Show Drop Zones

@ Show Apple logo watermark

‘Z‘ Enable background encoding

| Delete rendered files after closing a project

Video Standard

(ONTSC _
@ PAL This setting will take effect for new projects

For more about video standards, formats, and compression in general, see Appendix
B.

Resolution also matters. The ideal size for graphic images is 640 x 480 pixels. If your images have a different proportion, a
couple of things can go wrong: Either the images won't fill the entire menu or button, leaving you with undesirable black
bars in the empty space; or iDVD will resize the image, making it distorted or pixelated. To make your images fit the
DVD window exactly, use a photo-editing application to resize the image to 640 x 480. For images being used as a button,
any width and height with a 4:3 ratio will work.

Nobody wants a squashed ancestor, but that's just what I got for importing a wrong-sized graphic into iDVD:
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This is supposed to be my infamous uncle Yogi LeVitus, who once said, "Don't squish
my picture if you can avoid it."

Sometimes iDVD displayed this image with black bands on either side:

Neither of these alterations is what I wanted. So I put the image of Uncle Yogi back into my image editor (Photoshop 7, if
you must know) and resized it to 640 x 480. That made Uncle Yogi look just right:

For video, the ideal size is 720 x 480 pixels. If you import video that's smaller than the standard DVD size of 720 x 480
(NTSC) or 720 x 576 (PAL), iDVD will scale it to fit the DVD window, which will almost certainly degrade the image
quality.

One last detail to check before you import any images into iDVD is to make sure your images are oriented correctly. Flip
any images that are horizontal in an image editor so they're not sideways in your DVD.

Gather Your Images

Chances are, your images and movies are in various folders spread all over your hard drive. To make it
easier to stay organized, to back up your project as quick as possible, and to speed up burning the DVD,
move all the assets into one folder. You should also keep your iDVD project file in this folder as well, once
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you create it.

You don't have to create every bit of the content that goes on your DVD. Let's say at the last minute you
want to use a beautiful sunset as the backdrop on a secondary menu, but you don't have any decent sunset
shots in your collection of photos. Don't despair—the Internet is your friend in these desperate moments.
There are plenty of sites that supply absolutely free images as long as you're not using them for commercial
purposes. (If you do want to use them commercially, you'll have to get permission for copyrighted
materials.)

Free Graphics.com (www.freegraphics.com) has a database of sites with images that are free for the taking. If
you want the best that a little money can buy, take a look at the royalty-free images at Corbis' site
(www.corbis.com). There are plenty of beautiful images in the $50 range. The video clips are a bit more
pricey, though, and probably not a good use of funds for personal projects, but if you're going for the big
Hollywood production look (or shooting for an Oscar), these clips might be a better investment.

Let's Do It!

You don't have to make any decisions about your DVD's aesthetics just yet. Whether you want a motion or still backdrop
or whether you want a fancy font for titles are choices that you can make later. Your first task is to figure out in which
menu you'll put your movies and slideshows. That's right, your DVD can have more than one menu—many more. Now is
the time to decide which elements will go in the opening menu and which elements will go in secondary menus.

You can have up to six buttons in each menu screen. If you want all the buttons to go on the opening screen and you have
no more than six items, then you're finished with your planning.

Personally, even if I had only six items to show off, I'd arrange them in more than one menu. You'll have a more
interesting organization that way. And if you have more than six elements, you have no choice but to go the
multiple-menu route. Get out your pen and paper or fire up your planning software and make a simple drawing of the
structure of your DVD.

The LeVitus Family in
Our First DVD!

IB';OY: Jump! Slide show
footbal Mo pode i
- video grade pla
movie ’
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. Slide show "See
Car Wash of 2001 Food™
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Cotillion movie
short
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Of course you don't have to plan if you only have a few items. But the more assets you
have, the more you'll benefit from this up-front investment. It takes a lot more effort to
rearrange the menus later than to plan ahead of time.

For my project, I have six items—four videos and two slideshows—on the opening menu. If I had more than six items, I
would make one of the six items on the opening menu screen a folder button (to take viewers to a secondary menu). If
had more video clips, they would go inside this folder. Then, if | had more than 12 items, I could add a folder button to
the second menu screen, to take viewers to yet another menu. And so on.

This approach sounds more complicated than it is. Once you've worked with iDVD a
few times and seen how it uses folders to hold the secondary menu's content the whole
menu/folder metaphor will become second nature to you.

Import Movies and Images

Yes, it's time to actually launch iDVD so set your plans in front of you. Yea! If your sample project comes up on-screen,
select New Project from the File menu for a fresh start.

It doesn't matter what theme is showing. Whatever it is, it's just serving as a placeholder while you import your media
assets.

Why do you want to start importing assets before you diddle with the theme? Glad you asked! iDVD will encode them in
the background while you play with themes and buttons, but only if you import them first.

If you're already well-versed in iDVD, you could choose the appropriate theme now.

But since we're going to change it soon, don't bother—just use whatever's showing so
you can get the encoding process started.

Import movies

If you have any movies on your plan for the opening menu, put them in the menu you have on-screen now. Here are a
couple of ways to do this.

Drag the movie file from the Finder onto the iDVD screen, as shown in Figure 5.2.

Figure 5.2. This seems the easiest way to import content, at least in my humble opinion.
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Or you can go to the File menu, choose Import, then Video, as shown in Figure 5.3. Finally, navigate to your movie file

and select it.

Figure 5.3. Maybe it's me, but | think this is more work than drag and drop.
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Voila, iDVD places a button in the menu for playing your movie. It's just like the process you followed for the tutorial in

Chapter 3, but this time you're using your own material.

If you have the Motion button turned on, your movie should be playing within the movie button. Motion can be annoying
while you're trying to work, but you can turn it off by clicking the Motion button.

m Be sure to save your work frequently, just as you do in your word processor or any
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| program that requires saving changes. It's easy to get wrapped up in creating your
project and forget this crucial task.

The good news is that when iDVD 3 crashes it doesn't take down the whole Mac with
it the way it used to in Mac OS 9. The bad news is that it does sometimes crash, and
you still lose everything since the last save.

Import images for slideshows

The process for importing slideshows is different from that for importing movies. First, you must create a button and then
import images. Just click the Slideshow button below the menu or choose Add Slideshow from the Project menu to make
a new button representing your slideshow appear on the current screen. Then double-click the new button to open the
slideshow editor.

Importing your images is now a simple matter of dragging them from your project folder in the Finder and dropping them
into the slideshow editor. You can put up to 99 slides in each slideshow, and you can have up to six slideshows per screen
(menu).

While you have the slideshow editor open (see Figure 5.4), let's do a little customizing. You can make the thumbnail

images of your slides large or small by choosing the size from the Thumbnail pop-up menu.

Figure 5.4. You can view your images in two different sizes in the slideshow editor. Enlarge them, as
| have here, so that you can see them well. Or keep them small so that you have a better view of the
number and order of your slides.
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Choices made here affect only this window and have no impact on the size of the
slides you'll see when you watch the slideshow.

Slideshow vs. slideshow

The distinction between buttons that you create on DVD screens (menus) and the buttons at the bottom of
the iDVD window that come with iDVD, can be confusing. For instance, there's a Slideshow button (with a
capital S) in the brushed chrome below the screen. And there's also a slideshow button (with a little S) on
the screen. And they're two entirely different objects with two totally different functions. How much more
confusing does it get than that? The difference is, of course, that you create the slideshow that goes on the
screen menu and the one at the bottom of the iDVD window is inextricably part of the iDVD application.

How long do you want each image in your slideshow to stay on screen? You can choose 1, 3, 5, or 10 seconds from the
Duration pop-up menu. Or you can leave it on the default Manual option to let viewers click through your slides at their
own speed. The other duration option is Fit to Audio which is a good choice if you're planning to have sound play during
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the slideshow, since it matches the speed of the slideshow to the length of the audio clip. (I'll discuss this in greater detail,
as well as how to import audio, in Chapter 7, "Adding Audio.")

It's easy to change the order of your slides. Say you want slide 2 to come after slide 4. Just drag the slide's image in the
slideshow editor to the right spot.

You can add forward and back arrows to your slideshow by checking the "Display during slideshow" box. When displayed
on a TV, viewers won't be able to click the arrows on-screen to advance or reverse your slideshow, but the arrows will

indicate which buttons to push on the remote control. Basically, your audience will know if they're at the beginning,
middle, or end of your slideshow by looking at the arrows.

N\ | / 7 The arrows are clickable if you watch the DVD on your Mac.

Those are all the choices you have to make for now. Click the Return button to go back to the opening menu.

Create More Menus

You can make your DVD's structure as complicated as you like, with as many branches as a willow tree. But don't go crazy
or you'll lose your viewers. Simpler is often better.

Making an additional menu is easy. Just click the Folder button under the opening menu and a new button appears
on-screen. It's not pretty, but remember, we'll dress it up later. The purpose of this button is to get the viewer to another
menu. Double-click the button (or highlight it and press Return) and you'll be magically transported to the new menu that
contains nothing more than an arrow button and a generic title. Add slideshows, movies, and other folder
buttons—according to your plan—following the same steps you used to add items to the opening menu.

After you've finished adding items to this new menu, click the arrow button to return to the previous menu.

You can add as many menus full of movies and slideshows as you need to complete the structure of your DVD. Let's move
on to making it look pretty.
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